
Techwebinar - 2016



Eindhoven / Amsterdam 2016 

Techwebinar Interactive schedules

@kubusinfo #ARCHICAD19

2



Wat zijn Interactive Schedule? 

Hoe maak ik een Interactive Schedule? 
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opmaak 
opslaan en afdrukken 

Interactive Schedules in de praktijk: 
massastudies 
ramen en deuren staat 
meetstaten 

Vragen.....?
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WAT ZIJN INTERACTIVE SCHEDULES?



Wat zijn Interactive Schedules?

Interactive Schedules

Weergave mogelijkheid van het model in de vorm van lijsten. 

Input is output 
Om in lijsten een betrouwbare output te kunnen genereren moet het model uiteraard goed opgezet zijn. Maar ook met 
een minder goed opgezet model kunnen Interactive Schedules een grote hulp zijn om bijvoorbeeld fouten op te sporen. 
Deze kunnen dan deels direct in de lijst gecorrigeerd worden. 

Noot: 
In ARCHICAD bestaan ook ‘Lists’, waarmee ook lijsten opgeroepen kunnen worden. Dit is een oudere 
techniek en wordt niet veel meer gebruikt. Beperkingen hiervan ten opzichte van de Interactive Schedules  
zijn: 

•het is een momentopname 

•er kunnen geen projectwijzigingen in doorgevoerd worden 

•het instellen is veel complexer 

•de opmaakmogelijkheden zijn zeer beperkt
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Mogelijkheden van Interactive Schedules

Interactive Schedules

•Controleren van het model 
Staan alle elementen op de juiste laag en corrigeer dit direct  

•Wijzigen van element eigenschappen  
Voeg eenvoudig eigenschappen toe of wijzig bestaande eigenschappen 

•Selecteren van elementen in het project  
Kijk direct waar deze elementen staan op plattegrond of in 3D.  
Bij TeamWork projecten kunnen de elementen zo ook eenvoudig gereserveerd worden. 

•Zoeken op en controleren van IFC eigenschappen 
Belangrijk bij het uitwisselen in BIM projecten 

•Uittrekken van hoeveelheden 
Te gebruiken voor meetstaten en eenvoudig te exporteren naar excel  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Oproepen en Openen

Interactive Schedules

Openen Interactive Schedules 
Het openen kan op een van de volgende manieren: 

•Dubbel-klik in de Project map > Schedules op de gewenste lijst 

•Dubbel-klik in de View map op een als view opgeslagen Schedule 

•Het menu Document  >  Schedules and Lists  >  Schedules  > Keuzelijst van de Schedules 

•Vanuit de Scheme Settings 

Openen Scheme Settings 
Het openen kan op een van de volgende manieren: 

•De knop ‘Scheme Settings…’ in een opgeroepen Schedule 

•Het menu Document  >  Schedules and Lists  >  Schedules  >  Scheme  

•Contextmenu (rechter muisklik) op Schedules in de Navigator  >  Project Map of View Map
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INSTELLEN INTERACTIVE SCHEDULES



Scheme Settings

Instellen Interactive Schedules

De Scheme Settings bestaan uit 3 onderdelen: 

•Schemes 
Hierin worden de verschillende lijsten georganiseerd. 

•Criteria 
Hierin wordt bepaald van welke ARCHICAD elementen gegevens 
verzameld worden. Het hele model wordt gefilterd totdat alleen de 
elementen overblijven waarover de Schedule moet gaan. 

•Fields 
Hierin wordt bepaald welke gegevens getoond worden. 
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Nieuwe Schemes

Instellen Interactive Schedules

Het toevoegen van nieuwe schemes werkt als volgt: 

•Create New.... 
Kies hierbij voor bij Items voor: 

•Construction Elements  
Voor alle basiselementen 

•Components 
Speciaal voor informatie over elk onderdeel van 
composieten 

•Surface 
Speciaal voor het uitlezen van gekoppelde surfaces 

•Duplicate... 
Maak gebruik van een bestaande Scheme en pas deze 
daarna aan. 

•Import... 
Vanuit andere projecten kunnen of de KeyMember modules 
kunnen eenvoudig bestaande Schedules toegevoegd 
worden. 

10



Criteria instellen - basis

Instellen Interactive Schedules

Het filteren van de elementen waarvan de Schedule gegevens moet 
gaan verzamelen: 

1. ‘Element Type’  
Dit is een verplicht onderdeel (Slab, Walls, All Types, etc).  

2. Extra criteria: Add-knop 
Voor verdere specificatie: kies het criterium en stel de waarden in. 
De mogelijkheden hangen af van het gekozen criterium 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Criteria instellen - verder uitwerken

Instellen Interactive Schedules

Het filteren van de elementen waarvan de Schedule gegevens moet 
gaan verzamelen: 

• Haakjes 
Groepeer criteria die bij elkaar horen, zodat complexere criteria 
overzichtelijk blijven. 

• And/or 
Met deze optie kan een gelijktijdigheid van de verschillende 
voorwaarden aangegeven worden 

• Parameters en IFC Properties toevoegen 
Via het kleine pijltje bij de Add-knop 
 
Bij bibliotheek-elementen (Objecten, Ramen, Deuren, etc) kunnen 
parameters van deze objecten als criteria worden toegevoegd. 
 
Aan alle elementen kunnen IFC eigenschappen worden toegevoegd 
en hiermee kan daar op gesorteerd worden. 
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Fields instellen - kiezen van informatie

Instellen Interactive Schedules

• Welke informatie tonen 
Sleep de gewenste Parameters van links naar rechts of gebruik de 
Add-knop 

Zwart = niet aanpasbare parameter 
Blauw = in de Schedule aanpasbare parameter  

Uitgegrijsd = deze parameter is reeds geselecteerd 

• Parameters en IFC Properties toevoegen 
Via het kleine pijltje bij de Add-knop 
 
Bij bibliotheek-elementen (Objecten, Ramen, Deuren, etc) kunnen 

parameters van deze objecten als criteria worden toegevoegd. 
 
Aan alle elementen kunnen IFC eigenschappen worden toegevoegd 
en hiermee kan daar op gesorteerd worden.  

• Volgorde informatie aanpassen  
Gebruik de pijltjes voor de parameters (Schedule Fields) om de 

volgorde aan te passen. 
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Fields instellen - extra parameters

Instellen Interactive Schedules

Tips om de parameters van objecten snel te vinden: 
1. Kies de juiste methode bij ‘Select Object by’: 

1. Folder View: alleen indien de andere mogelijkheden niet passen 
2. Folder View (used Objects only):  alleen gebruikte objecten komen in de lijst 

3. Search criteria: als je naam van de gezochte parameter weet 

4. Favorite Objects: alleen objecten die ook als favoriet zijn ingesteld 

2. Kijk vooraf bij de objecten hoe de parameters of IFC properties heten 

3. Organiseer de Available Parameters door op de titel te klikken 
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Fields instellen - verder uitwerken

Instellen Interactive Schedules

Selecteer de betreffende parameter(s) en verfijn de instellingen door de volgende keuzen te maken: 

•Sorteren 
Het pijlteken geeft aan of de gegevens op- of aflopend gesorteerd worden. 
 

•Totalen 
Hoeveelheden: Het somteken (Σ) geeft aan van welke parameter(s) het totaal van de optelling van de hoeveelheden wordt 

gemaakt. 
Aantallen: Het somteken 1 (Σ1) geeft aan van welke parameter(s) het totaal van het aantal wordt gemaakt. 
 

•Subverdeling en subtotalen 
De vlag geeft aan over welk onderdeel een subverdeling (en subtotaal) wordt gemaakt. 
Plaats deze bijvoorbeeld achter de verdieping (Home Story), dan wordt per verdieping een subverdeling gemaakt. 

Tip: 
Gebruik ‘Show Headline’ in de opmaak om de eerste kolom als subverdeling te gebruiken 
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OPMAAK INTERACTIVE SCHEDULES



Opmaak - algemeen

Opmaak Interactive Schedules

De opmaak van Interactive Schedules kan op diverse plaatsen ingesteld worden:  

• De Interactive Schedule zelf 
Kolombreedte, rijhoogte, teksten  

• Het menu aan de linkerzijde van een gegeneerde Interactive Schedule 
Indeling, tekstformaat, opmaak afbeeldingen 

 
Tip: 
Aan de onderzijde zit een Cancel/Redo functie voor de opmaak.  

• Project Preferences 
Eenheden en nauwkeurigheid van de hoeveelheden en maten 
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Opmaak - kolombreedte en rijhoogte

Opmaak Interactive Schedules

Voor het aanpassen en instellen van de kolombreedte zijn drie mogelijkheden beschikbaar: 

•Dubbelklik op het kolom- of rijscheidingsteken  
De breedte of hoogte wordt automatisch aangepast aan de inhoud.  

•Verschuif het kolom- of rijscheidingsteken in de liniaal 
Ga met de cursor boven het scheidingsstreepje staan totdat de cursor verandert en sleep de kolom of rij op 
de juiste breedte of hoogte. 

•Numeriek 
Roep via de 3-puntsknop (naast de liniaal) het ‘Schedule Cell Size’ venster op. 
Per type kolom of rij kan hier een vaste waarde worden ingegeven. Alle kolommen krijgen dan automatisch 

dezelfde breedte, die uiteraard later wel per kolom weer is aan te passen.
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Opmaak - indeling

Opmaak Interactive Schedules

•Liggende of staande lijst  
Maak aan linkerzijde bij ‘Style’ de keuze: 

•‘Records by Rows’: staande lijst - Fields als kolomkop 

•‘Records by Columns’ : liggende lijst - Fields aan zijkant 

•Koptekst 
De naam van kolom- of rij koppen kan aangepast worden door op de zogenaamde Column header 
of Main header in de Schedule te gaan staan en de tekst aan te passen. In de Scheme Settings blijft 
de oorspronkelijke parameternaam staan.  

•Gelijke elementen wel/niet samenvoegen  
Vink ‘Show uniform items as a single entry’ aan of uit 
 
Als twee of meer elementen precies dezelfde waarden hebben worden deze samengevoegd tot één 
regel. Het aantal (Quantity) verandert dan mee. Als deze optie is uitgevinkt komen alle objecten 
apart onder elkaar te staan. 

 
Let op! 
Óf twee elementen gelijk zijn, wordt door ARCHICAD bepaald op basis van de ingestelde 

parameters voor de betreffende Schedule! Een 2D symbool of aanzicht telt daarbij niet 
mee; ARCHICAD kan niet bepalen of twee symbolen of aanzichten gelijk zijn of niet. 
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Opmaak - indeling

Opmaak Interactive Schedules

Om meer overzicht in de gegevens te krijgen kunnen een of meer van de gekozen parameters als 
kopteksten in de verdeling worden toegevoegd met de functie ‘Show Headline’. De waarde van de 
eerste velden komt als hoofdregel boven iedere verdeling. Hierbij zijn de volgende instellingen 
mogelijk via de knop ‘Settings...’. 

•Aantal velden 
‘Source of the headline’: maximaal het aantal ingestelde velden -1  

•Een extra regel wit  
Vink ‘Insert separator row before headlines’ aan. 

•Omschrijving van het veld  
Vink ‘Add header text to headlines as prefix’ aan. De omschrijving komt dan voor de waarde te 
staan. 

Let op! 
Aanpasbare parameters die als headline worden gebruikt zijn dan niet aan te 
passen. Vink of deze optie even uit of gebruik een anders Interactive Schedule  
voor het controleren en aanpassen.  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Opmaak - teksten en lijnen

Opmaak Interactive Schedules

Voor elk type regel kan een aparte opmaak worden ingesteld door deze regel te activeren selecteren in de 
schedule of het type te kiezen bij  ‘Apply Format Options to:’. 

Tip: 
Kies eerst ‘Entire Schedule’ om instellingen die voor alle types moeten gelden in te stellen.  

•Lettertype  
Met de bekende keuzen: pen en stijl (vet, cursief, onderstreept) 

•Hoogte van de rij 
Vast rijhoogte. Een passende rijhoogte is in te stellen via dubbelklikken op de rijseperatieteken van de 

Schedule zelf. 

•Grootte van de tekst  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Opmaak - teksten en lijnen

Opmaak Interactive Schedules

•Tekst passend in de cel 
Met ‘Wrap text’ lopen teksten die breder zijn dan de kolom automatisch door naar een volgende regel. 

•Uitlijnen 
Met ‘Align Column’ kunnen de kolommen links, midden en rechts uitgelijnd worden.  De vierde optie is ‘Align 
by Decimal marker’  waarmee uitgelijnd kan worden op basis van de plaats van de komma.  
  

•Omtreklijn 
Kies bi Cell Border aan welke zijde(n) een lijn gewenst is inclusief lijntype en pen. 
 

22

!

!



Opmaak - afbeeldingen

Opmaak Interactive Schedules

Kies bij ‘Apply Format Options to:’ voor ’Preview’ of ga op een afbeelding in de Schedule staan en maak de 
volgende keuzen: 

•Pennen 

•Overnemen van het symbool: vink ‘Enable Object’s Pens’ aan 

•Overschrijven: Kies de gewenste pen 

•Schaal 

•Op schaal: Stel de gewenste schaal zoals gebruikelijk en leg deze vast in de filters van de View 

•Passend in de cel: Vink de optie ’Reduce preview to fit into cell’ aan. Het symbool wordt verkleind als het 
groter is dan de cel.  

•Maatvoering (alleen ramen en deuren) 
Als in de Schedule ramen en/of deuren staan ) kan de optie ‘Add automatic dimensions’ aangevinkt worden. De 
instellingen van het Maatvoeringsgereedschap worden gebruikt voor de automatische maatvoeringslijnen. 
Kies bij ‘Dimension Settings…’ de gewenste afmetingen en positie van de maatlijnen.  

•Omtreklijn voor de cellen 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Opmaak - afbeeldingen

Opmaak Interactive Schedules

Extra informatie toevoegen 
Aan een afbeelding in de Interactive Schedules kan aanvullende informatie toegevoegd worden.  

Open de afbeelding op een van de volgende manieren: 

•Klik op een afbeelding en vervolgens op de knop ‘Annotate’  

•Dubbelklik direct op een 2D symbool om het Annotate venster te openen. 

Voeg vervolgens met 2D gereedschappen informatie aan het symbool toe. 

Let op! 
De opzet van de Schedule mag naderhand niet meer gewijzigd worden! Bij bijvoorbeeld een 

andere sortering gaan de annotaties verloren.  

Let op! 
De aanpassing geldt alleen voor de betreffende Interactive Schedule (vergelijkbaar met 
toegevoegde informatie aan gevel, doorsneden en andere vensters) 

24
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Opmaak - eenheden

Opmaak Interactive Schedules

•Ingestelde maten 
Neemt de instellingen bij Project Preferences > 
Dimensions over. Dit is in te stellen per View. 
Bijvoorbeeld hoogte en dikte van wanden. 

•Berekende en getekende maten  
De notatie van deze lengteafmetingen, 
oppervlakten en volumes in de Interactive 
Schedules wordt bepaald door de instelling bij 
Project Preferences > Calculation Units & Rules
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Opmaak - tips

Opmaak Interactive Schedules

•Kleurcodering 
Om tijdens het werken aan Schedule een goed overzicht te kunnen behouden tussen de verschillende type Schedules, kan een 
kleur codering aan de Schedule toegevoegd worden: 
 
Activeer bij ‘Apply Format Options to:’ ‘Entire Schedule’ en wijzig de Font Pen. 
 
Voorbeeld: 
Als alle teksten groen zijn, betekent dit het een lijst is voor de controle van het model.  

•Bewerken als losse tekst 
Schedules kunnen naar een Worksheet gekopieerd worden, om daar als losse lijnen en teksten bewerkt te worden. Dit is met 
name bruikbaar als deze 2D symbolen bevatten. 
 
Activeer de Schedule en kies Edit  >  Copy en kies Edit  >  Paste op de Worksheet. 
 
Voorbeeld: 
Maak van een lijst met alle gebruikte objecten een renvooi. 

26



OPSLAAN EN AFDRUKKEN



Opslaan

Opslaan en afdrukken

De tabellen worden in het project zelf opgeslagen. Voor het gebruik buiten het project zijn er de volgende mogelijkheden: 

•Scheme gebruiken in ander ARCHICAD project 

•Ga naar de Scheme Settings 

•Selecteer de Scheme 

•Kies voor ‘Export’. 

•Sla het bestand (*.xml) op een handige locatie op. 
Met ‘Import’ kan een Scheme vervolgens in een ander project binnengehaald worden. 

•Schedule gebruiken in ander pakket  
Om gegevens verder te bewerken buiten ARCHICAD, kan de tabel worden opgeslagen als tekst- of spreadsheetbestand (Excel) of 

als pdf-bestand: 

•Activeer de Schedule 

•Ga naar File > Save as en kies het gewenste bestandsformaat. 

Tip: 
Neem veel gebruikte Schedules op in de bureautemplate. Ze zijn dan automatisch beschikbaar in elk nieuw project.
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Afdrukken

Opslaan en afdrukken

Het afdrukken van Interactive Schedules werkt hetzelfde als voor andere venster in ARCHICAD. 

Direct Printen 
Een tabel kan direct afgedrukt worden naar de printer via  File > Print…  

Op een layout plaatsen 

•Maak een View aan 
Via de Organizer of ga in de Navigator > Project Map op de Schedule staan, klik met de rechtermuisknop en kies ‘Save Current 
View… ‘ 

•Plaats deze View op dezelfde wijze op een Layout als de overige Views. 
Deze wordt direct geüpdatet met andere drawings (zelf in te stellen met Update type). De schaal van de view is belangrijk om de 

symbolen (previews) op schaal te zien. 
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MASSASTUDIES



Morph Tool

Massastudies

Sinds ARCHICAD 17 kan het oppervlak en volume van een Morph per verdieping bepaald worden. 
Stel  
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Zone Tool

Massastudies

De zonetool kan ook gebruikt worden voor massa studies. 
Verschillen met de Morph Tool: 

Voordelen: 

•meerdere categorieen 

•meer eigenschappen 

•meer geschikt voor gebouwniveau 

•rechthoeken oprekbaar met behoud van oppervlak 

•meer informatieweergave op plattegronden 

Nadelen: 

•tekenen per verdieping 

•alleen zichtbaar op verdieping waarop getekend is 

•niet zichtbaar in doorsneden en gevels 

•vrij vormgeving met SEO 
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RAMEN EN DEUREN STAAT



13-

KeyMember Editie 
Tip & Truc 043: Werkmethodiek ramen- en deurenstaat KME

Tekeningen uitwerken - Ramen en deuren merken

In de ArchiCAD KeyMember templates zijn een aantal views aangemaakt ten behoeve van raam- en deurstaten. 
Hiermee kunnen alle ramen en deuren snel en makkelijk met een merknaam worden voorzien. 

 
Stap 1. Ramen en deuren merken met behulp van een schedule (ook in standaard NL/BE) 
 view: 1 Merken 

Stap 2. Gespiegelde merken 
 view: 2 Gespiegelde merken checken 

Stap 3. Visuele controle 
 view: 3 Visuele controle

34
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13-

Stap 4. Output 
 view: 4a Output 1 op 50  
 view: 4b Output 1 op 100 

Extra Ramen en deuren uitgebreid 
 Ramen en deuren uitgebreid biedt een overzicht van  
 alle mogelijk parameter die in een schedule zijn op te vragen 

De KeyMember Editie bevat een complete ramen- en deurenstaat. Alle benodigde views, layouts en  
instellingen zijn in de KeyMember templates verwerkt. Er kan gekozen worden voor een ramen- en deurenstaat als 

overzichtstekening of een ramen- en deurenstaat A4 (één raam of deur per A4 vel). 

Voor het maken en instellen van de ramen- en deurenstaat  
raadpleeg de volgende Tips & Trucs : 

• 029: Schedules maken 
• 043: Werkmethodiek ramen- en deurenstaat 
• 044: Instellingen ramen- en deurenstaat wijzigen 

KeyMember Editie 

Tekeningen uitwerken - Ramen en deuren merken
35
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Ramen en deuren weergave

2D symbool  
Gekoppeld aan een schedule kunnen instellingen worden 
gemaakt betreft het 2D symbool. Deze zijn beschikbaar in een 
Model View Option Combinations. 

•Basis opzet (1/4) 

•Welke maatvoering is zichtbaar (peilmaatvoering, breedte/
hoogte maatvoering) 

•Welke accessoires zijn zichtbaar 

•Plattegrond weergave 

36

Ramen- en deurenstaat



Ramen en deuren weergave

•Extra opties (2/4) 
Gekoppeld aan een schedule kunnen instellingen worden 
gemaakt betreft het 2D symbool 

•Interieur ramen- en deurenstaat 

•extra teksten voor accessoires 

•Opmaak (3/4 en 4/4) 
Gekoppeld aan een schedule kunnen instellingen worden 
gemaakt betreft het 2D symbool 

•Maatvoering  

•Peilmaatvoering 
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Ramen en deuren weergave

•Ramen en deurenstaat op A3/A4 

•Sleep de view op een A3/A4 layout en stel de Drawing zo in 
dat een nieuwe layout wordt begonnen zodra de layout vol 
is.  

•Kies bij de Drawing Settings de optie Split Drawing among 

Multiple Layouts.  

•Vervolgens kan in de Zoombalk onderin het scherm 
geschakeld worden naar de verschillende sub-layouts.  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MEETSTATEN VOLGENS VMSW



Voorbereiden van een (VMSW-)meetstaat

AANBESTEDINGSDOSSIER

Vanaf ArchiCAD 18 is het mogelijk om schedules te maken die specifiek artikelnummers en -omschrijvingen 
bevatten. 

•VMSW-lastenboek: 
VMSW is één van de meest gebruikte basisbestekken in Vlaanderen. 
Architecten(kantoren) met een eigen moederbestek vertrekken vaak vanuit VMSW en bouwen verder op 

de structuur 
Het VMSW-bestek is vrij consulteerbaar 

•Artikels opnemen in een ArchiCAD-model 
Nieuw in ArchiCAD 18: extra informatie toevoegen aan Building Materials 
Alle wijzigingen in materiaalkeuzes en hoeveelheden worden onmiddellijk doorgevoerd in de meetstaat-

voorbereiding. 
Het koppelen van de artikellijst (VMSW of eigen bureau-standaard) kan centraal beheerd worden door 
slim gebruik te maken van attributen 

Let op! 
De beschreven werkmethodiek maakt geen live-koppeling tussen het ArchiCAD-model en lastenboek-
documenten (xlsx, docx, …). Uiteraard kan de XLS-export van ArchiCAD makkelijk geïntegreerd worden in een 

eigen (VMSW-)meetstaat 

Tip 
Je kan ook een eigen bureau-bestek op dezelfde manier integreren in je ArchiCAD-projecten. 
Het is ook mogelijk om in het model de specifieke product-informatie (merk&type) te bewaren waarop een 
bestekartikel is gebaseerd. 



Overzicht van de template-inhoud

AANBESTEDINGSDOSSIER

In de template zijn – naast de gekende schedules - een aantal specifieke zaken voor de voorbereiding van een 
(VMSW-)meetstaat opgenomen 

•Elk Building Material heeft de best passende VMSW-code en –omschrijving meegekregen 

•Er zijn 3 Interactive Schedules aan de template toegevoegd: 

•Samenvattende meetstaat van alle hoofdstukken:  
deze heeft een algemeen overzicht van alle gebruikte artikels in het project 

•Detailmeetstaat van Hoofdstukken 10-90 van het VMSW-bestek: 
deze bevat alle nodige meetinfo van de verschillende onderdelen uit het model 

Tip 
Er kan onmiddellijk met de template begonnen worden met modelleren en de 

Interactive Schedules zullen ingevuld worden, met artikelnummer en –omschrijving. 
Uiteraard moet er op een later moment verder verfijnd worden (materiaalkeuzes e.d.), 
maar op deze manier is er van bij de start een goede voorbereiding van de bestekfase. 
 
Uiteraard kunnen er - op basis van de opgenomen voorbeelden - veel meer artikels 
toegevoegd worden. 



Artikelnummers en -omschrijvingen toevoegen aan Building Materials
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•ID & Description bij Building Materials 
In ArchiCAD 18 zijn er enkele standaard kenmerken toegevoegd aan de Building Materials. Naast de Physical properties, 
kunnen we nu ook een ID, Manufacturer en Description toevoegen.  
Het Manufacturer-kenmerk is uiteraard bedoeld om informatie over de fabrikant van het materiaal toe te voegen. Vanuit het 
oogpunt van een neutraal bestek, zoals dat van het VMSW, wordt dit in eerste instantie dan ook leeg gelaten. De overige 2 
kenmerken gaan we wel gebruiken: 

• ID:  bedoeld voor unieke identificatie – hier vullen we het (unieke!) artikelnummer in 

•Description: veld voor omschrijving (onbebeperkte lengte) – hier vullen we de omschrijving in 

Tip: 
Het artikelnummer verschijnt ook in de overzichtslijst van de Building Materials (links op de afbeelding). Dit heeft als voordeel dat je 
nu ook de Building Materials op artikelnummer kan rangschikken.



Artikelnummers en -omschrijvingen toevoegen aan Building Materials
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•Werkmethodiek om VMSW-artikels te koppelen aan Building Materials 
Om artikelnummers en –titels toe te voegen, ga je als volgt te werk: 

•Open de Building Materials in ArchiCAD 

•Kies het Building Material waarvoor je nummer en titel wil 
toevoegen (1), of kies voor New… en maak een nieuw materiaal 

aan (2) 

•Vul bij ID het artikelnummer in (3) 

•Vul bij Description de bijhorende titel in (4) 

•Bevestig met OK – de aanpassingen worden bewaard (5) 

Let op! 
De template is een aanzet naar de artikelen uit het VMSW-bestek. Elk 
project dient verder gespecificeerd te worden.



Artikels toevoegen aan het model
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Artikels (nummer en omschrijving) kunnen op 2 manieren worden toegevoegd aan de Building Materials in een model: 

1. Manueel – bij aanmaak van een nieuw materiaal wordt de ID en de Description correct ingevuld: 
•Voordeel: werkt snel voor 1 artikel – het ontwerpproces moet niet ‘onderbroken’ worden 

•Nadeel: zeer omslachtig bij uitgebreide modellen waarbij veel artikels moeten toegevoegd worden 

2. Via de Attribute Manager kunnen de nodige artikels worden binnengehaald: 
•Voordeel: je kiest enkel de artikels die op dat moment van toepassing zijn (geen vervuiling) 
•Nadeel: je attributen moeten goed georganiseerd zijn (risico op ongewenste overschrijvingen) 



Artikels toevoegen aan het model
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•Artikels manueel toevoegen 
Via de Building Materials 

•Artikels toevoegen via attributen 
Om Building Materials (en de bijhorende artikelnummers en –omschrijvingen) via de Attribute Manager toe te voegen aan een project, 
ga je als volgt te werk: 

• Kies in het actieve project voor Options>Element 
Attributes>Attribute manager… 

• Kies voor Open 

• Blader naar het bestand “VMSW_BM_Hfdst-20.aat” 

• Selecteer de gewenste Building Materials en voeg ze toe 
By index - vink hierbij Include Cut Fills en Surfaces uit 

• Kies rechts onderaan voor Apply en kijk na of enkel de 
Building Materials worden toegevoegd (en er geen Fills of 

Surfaces ongewenst worden overschreven) 

• Bevestig met OK, de gewenste artikels zijn nu beschikbaar 
onder Building Materials 

Tip: 
Je kan meerdere Building Materials selecteren door de Cmd/Ctrl toets 

te gebruiken bij het aanklikken van de materialen in de rechterkolom. 



Resultaat na verfijning / diversificatie
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DIVERSIFICATIE
EIGEN ARTIKELS
SPECIFIEKE TOEPASSING



CODERINGEN



Tabel toevoegen aan ARCHICAD

IFC Coderingen

Aan elementen kunnen IFC codes worden toegevoegd. Dit kan handmatig of vanuit een keuzelijst. 

Gebruiken coderingstabel 
De extra coderingstabellen zijn beschikbaar bij Element Selection > Default Settings > Tags and Categories > Manage IFC 
Properties...> Apply Predefined Rule: 

•Kies bij Select Rule voor NL/BE Coderingstabellen 

•Kies daaronder een codering bijvoorbeeld NL/Sfb, STABU, NEN2699 of EcoQueastor 

•Kies in de boomstructuur de juiste code. 

Uitgebreide uitleg over het gebruik staat in Tip & Truc 076 Elementcodering toevoegen aan een ARCHICAD-BIM model 
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vragen.....? 



UPCOMING WEBINARS 

30/6    IFC gebruiken in ARCHICAD 

7/7       Parametisch modelleren met Rhino Grasshopper  

http://www.kubusinfo.nl/activiteiten

http://www.kubusinfo.nl/activiteiten

